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11. HEAT AND MATERIAL BALANCE

BN Heat and Material Balance - D:\HSC5\Balance\Cucony1.bal

File Edit “iew Inzett Delete Fommat Unite Calculate Target Diagram  Option:  Help

| A1 EXTRS HEAT:
INPUT SPECIES (1) Temper. Amount Amount Amount | Latent H TotalH | =
Formula o¢ kel kg Nm? MJ MJ |
1 | GAS: 25000 4386 126,537 99 971 oo 0,000
2 |Ng 25.000 3465 o7 D66 78920 0.000 0.000
3 0D 25.000 0.921 20 471 20991 0000 0.000
4 FLUX: 25000 0215 120918 0.003 oooo 195534
5 (302 25.000 0.215 12018 0.005 oo 195834
6 MATTE: 1250000 1 040 127048 0024 04 206 27 347
7 |CulsD 1250000 0.500 79,576 0014 54919 20 260
8 |Fel(h 1250000 0.540 47 470 0.010 41377 6.477
9 COOLING SCRAP: 25.000 0.000 0,000 0.000 oo 0,000
10 |Cu 25.000 0.000 0.000 0.000 0.000 0.000
11 |EXTRA HEAT: ! 0,000
12
13
14
15
16
17 -
A rhBL AN A DUTT S N LlJ
kol kg Nm? MJ MJ

E it | < | > | BALANCE (1)| -0.807 0.000: -6.920 | 200 26 8074

Fig. 1. Heat and Material Balance workbook with IN1, OUT1 and BAL sheets.

Heat balance calculations are usually carried out when developing new chemical processes
and improving old ones, because no process can work if too much heat is released or if
there is a lack of thermal energy to maintain the reaction temperature. This module
calculates the real or constrained heat balances, with given mass-balances as the boundary
conditions, but not the theoretical balances at equilibrium conditions.

The heat balance application always contains IN1, OUT1 and BAL sheets. A pair of IN
and OUT sheets is called a Balance area, which may be considered equivalent to a control
volume. A total number of 127 balance areas may be inserted, to create a multiple balance
area workbook. Multiple balance area workbooks are explained in more detail in chapter
10. Multiple balance areas. For simplicity only the first balance area (IN1, OUT1) will be
described in the following chapters.

The basic idea of the heat balance module is that the user specifies the IN1 and OUT1
species, temperatures and amounts and the Heat Balance module automatically calculates
the heat and material balances using the BAL sheet. The Heat balance module updates the
calculated results on the BALANCE row at the bottom of the form each time the user
changes the input data. Please do not modify the BAL sheet.

Since the program uses and creates new balance areas according to the name of the sheets,
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it is extremely important that the automatically created sheet names, i.e. the BAL, INx
and OUTx sheets, should not be modified.

You can also add new sheets for other spreadsheet calculations using the Insert Sheet and
Insert Excel Sheet selections in the menu. The other sheets work very much like MS Excel
worksheets, for example, you can:

rename the sheet name by double clicking the sheet tab

type formulae into the cells

use similar cell references as in Excel

use most of the Excel functions

link the sheet to IN1 sheet using normal Excel cell references, for example, for
converting elemental analysis of the raw material to amounts of the components.

use the heat balance calculation results in OUT1 sheet as the initial values for other
spreadsheet calculations.

In addition the Heat Balance menu provides a wide range of Excel type features, such as:
number, font, alignment and border formatting, defined names settings and cell protection.
Because they are not necessarily needed in heat balance calculations, these features are not
described here in detail.

The new heat balance module offers several ways to calculate heat and material balances:

1.

The user types the input and output species, temperatures and amounts into the IN1
and OUTT sheets respectively. This is a simple way to calculate heat and material
balances and was available already in HSC 2.0. However, the problem with the old
version was that the user had to manually maintain the material balance when the
input feed changed.

Materials (species) are given as groups of substances, called streams. These streams
can be the same as the phases, but they can also be a mixture of phases.

The output amounts can be linked with the input amounts with Excel type cell
references, or vice versa.

11.1 Basic Calculation Procedure

The following procedure will describe the most simple way to calculate Heat Balance:

1.

Introduce the input substances (raw materials), temperatures and amounts on the
IN1 sheet. It is possible to either type amounts in kmol, kg or Nm3. It is advised to
use kmol and kg because missing density data may cause inaccuracy with Nm3
units.

Introduce the output substances (products), temperatures and amounts on the OUT1
sheet. Type amounts in either kmol, kg or Nm3 as preferred.

When feeding additional energy (electricity) to the process, enter this amount into
the Total column in the last empty row of the IN1 sheet. You can also type for
example “Extra Heat” in the first column of this row, see Fig. 20. The Database
module will convert the color of all “inert™ text in the first column to green, if this
text is not identified in the database as a substance. Notice that:

1 kWh = 3.6 MJ = 0.8604 Mcal (th).

However, the Balance module will automatically recalculate green text when
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changing units from the menu. If the green text cell contains a formula, it will
automatically be changed according to the new unit. For example a change from
°C to K will add “+ 273.15” to the end of the formula.

If heat loss values are known then type them into the last empty row of the OUT1
sheet in the last column (Total). A first estimate of heat losses for an air-cooled
reactor (natural convection) can easily be calculated using the following formula in
kcal/h:

Hloss = (6.8 + 0.046 * Tp) * (T -Tq) * A [1]
Where: A = Outer surface area of the reactor (m?2)
Ty = Surface temperature of the reactor (°C)
T = Room temperature (°C)

Please use the Heat Loss module if more accurate heat loss approximations are
needed.

HSC automatically and immediately updates the heat balance on the bottom line as
soon as changes to any input data are made.

HSC also automatically updates the material amount balances in mol, kg and Nm3
units. Notice that only the mass balance in kg units on the bottom row should be
zero; the mole or volume balances can easily change in any chemical process.

The element balance can be checked by selecting Element Balance from the
Calculate menu, see Figs. 1 and 2.

By selecting Temperature Balance from the Calculate menu it is possible to see the
estimated temperature of the products when the heat balance = 0, see Figs. 1 and 3.

[E% Element Balance o [=]

IH1 ouT1 BALAHCE

kool Fanol Fmol

cu 1.000 1.000 o.aoo
Fe 0.540 0.540 o.aoo
i) 6.930 6.930 o.aoo
] 2.272 Z.27:2 o.aoo
3 1.040 1.040 o.aoo
31 0.215 0.215 o.aoo
ko ko kg

cu 63.546 63.546 o.aoo
Fe 30.157 30.15%7 o.aoo
i) 97.066 97 .066 o.aoo
] 36.351 36.351 o.aoo
3 33.34:2 33.342 o.aoo
31 6.035 6.035 o.aoo
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Fig. 2. Element Balance.

Eﬂ- Temperature Balance _ O |

Temperature of products = 15708 C
[when Heat Balance = 0]

Fig. 3. Temperature of the products (adiabatic process).

9.

10.

11.

12.
13.
14.

15.

16.

To insert an empty row in the table, select Row from the Insert menu or by pressing
the right mouse button and selecting Insert Row from the popup menu.

Rows can be deleted by selecting Row from the Delete menu or pressing the right
mouse button and selecting Del Row from the popup menu.

You can change the order of the substances by inserting an empty row and using the
Copy - Paste method to insert the substance in the new row. The Drag and Drop
method can also be used. However, it is extremely important to Copy and Paste
the whole row not only the formula, because of auxiliary data in the hidden
columns on the right side of the IN1 and OUT1 sheets.

Please keep the Copy Mode selection on in the Edit menu when rearranging the
species, as this will force the program to select the whole row. When formatting the
columns and cells, turn the Copy Mode selection off in the Edit menu.

Temperature units can be changed by selecting the C or K from the Units menu.
Energy units can be changed by selecting Mcal, MJ or kWh from the Units menu.

If a paper copy is needed, select Print from the File menu. This option will copy all
the data on the same Print sheet and will also print this sheet on paper if the user
presses OK. Notice that you can delete this Print sheet by activating it and then
selecting Sheet from the Delete menu. The Print Sheet selection in the File menu
will print only the active sheet.

To save the sheets, select Save from the File menu. Please save sheets often using
different names, because you may wish to make small changes later or to return to
the original sheet. Saving sheets is important, because the Undo feature is not
available in HSC Chemistry.

It is possible to take into account the water/steam pressure compensation by moving
the cursor to an H20 or H2O(g) species and selecting Insert/Pressure correction
H20 from the menu. This will open the Pressure and Temperature calculator, where
it is possible to specify the pressure for the species. This is useful when calculating
for example steam processes.

11.2 Formatting the Worksheet

The heat balance module offers several Excel type formatting possibilities. These may be
selected in the Format menu:

Number, Font, Font Default, Alignment, Border, Pattern, Object (for graphical
objects), Sheet, Options
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- Column Width, Row Height
- Define Names, Refresh Names
- Protection On, Off, Lock all Cells, Unlock all Cells

The window size may also be changed from the View menu. The Normal selection gives a
VGA size window, Full Height selection uses the whole height of the screen and Full
Width fills the whole screen.

11.3 Specification of Substance Groups (Streams)

The new HSC Chemistry 5.0 offers the possibility to specify the input and output
substances in streams. These streams can be made of one or several physical phases or
species which have the same fixed temperature and elemental composition. Although heat
and material balance calculations can be made without using the streams, division into
streams helps considerably when changing temperatures and material amounts. Notice that
when using formulae/links in temperature cells the temperature cells are not updated if
the species are not divided into streams.

Examples of “one-phase streams” are, for example:

1. Air feed.
2. Process gas output.
3. Homogenous liquid and solid inputs and outputs.

Examples of “multi-phase streams” are, for example:

Liquid material with solid particles (suspension) as input or output.

2. Solid feed mixture of the process, made of different substances, such as mineral
concentrate, coal and sand.

3. Gas feed with liquid droplets or solid powder.
The species rows in the IN1 and OUT1 sheets are divided into separate groups by special

stream rows. These rows can be inserted in the sheet using the Stream selection in the
Insert menu or using the same selection in the popup menu from the right mouse button.

The heat balance module automatically makes the following modifications to the sheet
when you insert a new stream (group) row in the sheet:

1. Asks for a name for the new group, which you can change later if necessary.

2. Inserts a new empty row above the selected cell with a light blue pattern.

3. HSC assumes that all rows under the new group row will belong to the new group
down to the next group row.

4. Inserts Excel type SUM formulae in the new group row for calculating the total

amount in the group using kmol, kg and Nm3 units.
Once the insert procedure is ready, you can edit the group row in the following way:

1. The stream name (label) can be edited directly in the cell.

2. The stream temperature can also be changed directly in the cell and will affect the
temperature of all the species in this group.

3. The total material amount of the group can be changed simply by typing a new
amount in the group row in kmol, kg or Nm3 units. This amount can be typed
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directly over the SUM formula and the program will automatically change the
amounts of the species keeping the overall composition constant. The program will
then regenerate the original SUM formula after calculating the new amounts.

4. It is important to note that you are unable to type formulae in the amount and
enthalpy columns of the stream row, because the SUM formulae must be in the

stream row.

To change the amounts of species in a stream using kmol, kg or Nm3 units, simply type the
new amount in the corresponding cell. The program will automatically update the amounts
in the other columns, total amount of the stream and the total material and heat balance as

well.

An example of the species streams can be seen in Fig. 4. The output species have been
divided into four streams. In this example the species in each stream exist in the same

phase.

White Metal is a pure molten substance.

Process Gas is a gaseous mixture phase, Slag is a molten mixture phase and

IEEHeat and Material Balance - D:AH5C5\Balance\Cucon¥l.bal M= E3
File Edit “iew Inzert Delete Fomnat Unite Calculate Tarnget Diagram  Option:  Help
| a13  [HEATLOSSES:
OUTPUT SPECIES (1) Temper. Amount Amount Amount Latent H Total H | =
Formula “C kkmol kg Nm® A | i A ) |
1 [PROCESS GAS: 1250000 4082 135121 3044 174772 5292
2 |Na 1250000 3465 97 Oié Ta 980 135910 135810
3 [CdiE 12500000 0.04a 1477 1052 1913 1913
4 [302g 1250000 0571 30578 13012 36943 “133:531
5 [SLAG: 1300400 283 S0 TER A TR 274095
6 |[*2FeC*3102(0 1300.000 0215 43812 noio A3 545 247 561
T (Fe304D 1300.000 0.0z7 2490 000z R 26446
8 [CulCD 1300.000 0.031 4 436 000 3849 0088
9 | WHITE METAL: 1250000 04653 Tdad2 A B 51514 19576
10 |Cu23 1250000 0.4a58 T4 ad2 0oz 51514 19574
11 |METAL: 1250000 0.0 (S]] A H]E] 000 noon
12 |Cwh 12500000 0.000 0.000 0.000 Q000 0.oon
13 |HEAT LOSZES: ! 0.oon
14
15
16
17 -
| » AT, i il | biE
Jkmol kg Nm? AL AL
Exit | <|>| BavancE@[  -vs07] 0000;  -6929]  20986]  -80.74|

Fig. 4. The OUT1 sheet of the Heat Balance module. The species have been divided into three streams,
which are the same as the existing phases.
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114

Formulae in the Cells

Excel-type formulae and cell references can be used, for example, in order to link the input
and output amounts with each other and to maintain the material balance automatically
when the input amounts change. The input and output amounts can be linked using two
main methods:

1.

An Excel-type formula can be typed in the kmol column, which expresses the
dependence of the output mole amount on the input mole amount. For example, if
Cu2S in the cell OUT1!C10 contains 93.8 % of copper input then you may type
formula = 0.938*IN1!C7 in cell OUT1!C10, see Fig 5.

The Heat balance module automatically calculates input and output mole amounts
for elements. The cell names for input amounts are: InAc, InAg, InAl, InAm and the
equivalent for output elements are called OutAc, OutAg, OutAl, OutAm, etc. For
balance areas with a higher number (for example the IN2 and OUT2 sheets) the
corresponding cell names are simply InAc2, InAc3 and OutAc2, OutAc3, etc.
These names can be used in the formulae. The formula in the previous example can
also be written: =0.938*(InCu-C12)/2 using these defined names, see Fig. 5. The
cells with element amounts are not visible to the user.

Please be very careful when using default input and output names simultaneously,
because it is very easy to end up with circular references. An indication of a circular
reference is that the heat and material balance, which can be seen on the BALANCE
row, changes even after a recalculation (Calculate/ReCalc from the menu). By
selecting Format/Options from the menu and highlighting the Iteration checkbox
under the Calculation tab, it is possible to automatically iterate the circular
references. This is, however, not recommended for very large worksheets.

Within the IN1 and OUT]1 sheets it is recommended to use formulae only in the kmol
column and not in the other Amount columns. You can use the formulae also in other
columns, but please be very careful. In the other sheets there are no special limitations for
the formulae.
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BN Heat and Material Balance - D:\HSC5\Balance\Cucony1.bal

File Edit “iew Inzett Delete Fommat Unite Calculate Target Diagram  Option:  Help
| 10 |=n.933 #InCu-C12)/2
OUTPUT SPECIES (1) Temper. Amount Amount Amount | Latent H TotalH | =
Formula e kel kg Nm? MJ AL I
1 |PROCESS GAS: 1250000 4082 135121 93044 17772 5203
2 |Nig 1250000 3.4a5 oF Do T8 Q0 135810 135910
3 0% 1250000 0.04a 1.477 1.052 1913 1913
4 |[302(8) 1250000 0.571 36578 13012 36949 -132.551
5 |[SLAG: 1300000 0,283 56738 R AfE] FHET 274095
6 |*IFeC*30T 1300.000 0.215 43212 0.010 65949 247 561
7 |Fe304D 1300.000 0.037 2490 0.00z2 Q0748 26440
8 |Cull 1300.000 0.031 4434 0.001 3040 0088
9 AWHITE METAL; 1250000 0469 74642 HREHRE 51514 19578
10 [CuZ3l 1250.000f 0.4621 Td.642 0013 51.514 195748
11 METAL: 1250000 0000 o.oon 0.00a 8] RREH]]
12 [Cu) 1250000 0.000 0.000 0.000 o.ooo o.ooa
13 |HEAT LOS3ES: 0.ooo
14
15
16
17 -
Ao [ Bl A A oot S la| | L'J
Jamol Nm? MJ MJ
Exit | <|>| BALANCE@)[ 0307 000 -6929]  c09mel  gngd)

Fig. 5. The OUT1 sheet of the Heat Balance module. Copper output has been linked with copper input with

a formula and defined name: InCu.
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11.5 Elemental Compositions

The elemental compositions of the species groups may be calculated using the Stream
Compositions selection in the Calculate menu, see Fig. 6. This procedure calculates the
elemental compositions of each group, creates new Inl1-% and Outl-% sheets and prints
results on these new sheets in mol-% and wt-% units.

Notice that a procedure to convert elemental analysis back to species analysis is not yet
available in the heat balance module. A general solution to this kind of problem is quite
difficult and in many cases impossible. However, a custom-made solution for an individual
case is possible with a little effort and normal Excel-type formulae:

1.
2.

Create a new sheet using the Sheet selection in the Insert menu, see Fig. 6.

Rename the new sheet by double clicking the tab, for example to “Compositions”.
Notice that you can use also the Input-% sheet as the starting point as you rename it.

Type the elemental and species compositions on the new sheet.

Notice that you can insert Formula Weights in this new sheet by selecting the
chemical formula cells and then selecting Mol Weight from the Insert menu.

Create Excel-type formulae, which convert the elemental analysis of a group to mole
amounts of species using formula weights of the elements and species.

Type formulae in the kmol columns of the IN1 sheet, which refer to species amounts
in the Compositions sheet.
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BN Heat and Material Balance - D:\HSC5\Balance\Cucony1.bal

File Edit “iew Inzett Delete Fommat Unite Calculate Target Diagram  Option:  Help

| 11 0932
OUT1 Temper. Amount Amount Content Content | =
Compositions oc Lol kg mol- %o wi-% |
1 |[PROCESS GAS: 1250.000 2735 1351341 100,000 10060
2 ¥ £.930 27 066 0333 71837
3 |0 1.234 19749 14.130 14615
4 |3 0.571 18.306 6.537 13.548
5 [RLAG: 1300.000 1555 36738 100000 100,000
6 |Cu 0.062 3840 3343 f.544
T |Fe 0.540 30157 20116 53152
g |O 1.038 16602 55949 29261
N 0213 6,038 11.502 10643
10 |WHITE METAL: 1 250,000 1407 74642 100000 100.0400
11 |Cu I III.S'EE! 59 A06 66 66T TOESE
12 |3 0462 15,0348 33333 20.144
12 |METAL; 1 250,000 o.oo0 0,000 (000 ooeg
14
15
16
17
18 -
4| v [BL AT A OOTT A Il A, Outl-% I

loaol kg Nm? MJ MJ

E zit | < | > | BALANCE (1)| -0.807 0.000; -6.929| 209 864 -20.74)

Fig. 6. The Out1-% sheet of the Heat Balance module. This sheet shows the elemental compositions of the
phases, after the Stream Compositions option has been selected from the Calculate menu.
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11.6

Additional Sheets

The Heat Balance workbook consists at least of the IN1, OUT1 and BAL sheets. The user
may, however, add up to 256 sheets to one workbook. These additional sheets may be
used, for example, to convert the elemental compositions of raw materials to amounts of
species which are needed in the IN1 sheet. These sheets can also be used to collect the
main results from the OUT1 sheet in one summary table. Do not use the reserved names
IN1, OUT1, BAL and Target as sheet names.

To add sheets select Insert Sheet from the menu. This will add one sheet on the selected
location. To rename this new sheet, double click the Tab on the bottom of the form. You
can also import Excel sheets by selecting Insert Excel Sheet from the menu. This selection
allows you first to select the file and then the sheet which you want to insert into the active
Heat Balance workbook.

The example in Fig. 7 shows a FEED sheet, which is used to specify the raw materials
amounts to the IN1 sheet. The user may give the compositions and amounts in column C,
this data will then be used to calculate the amounts of species in column F. The material
amounts in IN1 sheet are given using relevant cell references to column F in the FEED
sheet. This example can be found from your HSC5\Balance directory under the name
CUCONV2.BAL. The user can construct the layout of the additional sheets freely.

The “Red Font Shield”property is a useful way to prevent accidental modification of the
data in the cells. If this property is set using menu selection Format, Red Font Shield then
only cells with red font can be edited. However, it is recommended to save the work
regularly using different names, for example, testl.bal, test2.bal, test3.bal, etc. in order to
recover the original situation after harmful modifications.



HSC Chemistry® 5.0 11-1

A. Roine, P. Bjorklund June 28, 2002 02103-ORC-T

BN Heat and Material Balance - D:\HSC5\Balance\Cucony2. bal

File Edit “iew Inzett Delete Fommat Unite Calculate Target Diagram  Option:  Help

Lo o
A B | ¢ [ p | E | F [ ¢ [ H | 4
1 |Copper Converter Feed |
2  |GAR: Amount: 00 97 MNm3'h
3 H2(g) 7900 val%  |N2(g) 7292 Nmih
4 02(g) 2100 val%  |o2(g) 2099 Nmih
5 |[FLUX: Amount: 1292 ka'h
G =i 10000 art-% =i 1292 kg'h
T  |MATTE: Amount: 12705 kag'h
8 Cu 0002 art-% Ui TA5T kgth
o Fe 2374 art-% FeliD 4747 kgth
10 = 2624 wt-% kgth
11 |SCRAP: Amount: | 0.000ke
12 Cu IDD.DD.E% Cu 0.00 kzih
13
14
15
16
17
18 -
41|\MLAIN1ﬁDUT1AFEEDATargetf la| | L'J
Ienol kg Im? i A ) i A )

E zit | < | > | BALANCE (1)| -0.807 0000 -6.520 209 86§ -50.74)

Fig. 7. Additional sheets can be added to the Heat Balance workbook.

11.7 Target Dialog

The user can iterate manually, for example, the fuel amount which is needed to achieve
zero heat balance by changing the fuel amount until the heat balance is zero. The Target
sheet offers a faster automatic way to carry out these kind of iterations. The following
instructions will explain this procedure in more detail:

1. Select Target Dialog from the menu. This will also automatically create a Target
sheet, which is similar to previous HSC versions.

Select one cell on row 4 in the Target dialog if not selected.

3. Select one cell which will be used as a first variable and select Set variable cell.
This will add the cell reference of this variable to the Target dialog in column B. You
can also type the cell references manually in the Target dialog. Note: Please use
only Stream temperature cells as variables for the temperature iterations, ie. do not
use species temperature cells.

4, Select one cell which will be used as first variable and select Set target cell. This
will add the cell reference of this variable to the Target dialog in column B.

5. Repeat steps 3 and 4 if you want to add more variables and targets.
Set valid Min and Max limits in columns D and E as well as the Target Value in
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column H. You may also type names in columns A and F.

7. Usually it is also necessary to give estimated initial Test Values in column C for the
automatic iterations. Iteration ends when the target value (col H) or iteration number
(col 1) is reached. Accuracy can be improved by increasing the number of decimals
used in columns G and H with the Format Number selection.

8. Select the rows (> 3) on the Target sheet which you want to iterate and press Iterate
selected rows or F8. If all rows should be iterated, simply press Iterate All

In the following example, shown in Fig. 8, you can select for example row 4 and press F8.
This will evaluate the copper scrap amount which is needed to maintain the heat balance in
the given conditions. Row 5 can be used to iterate the iron content of the matte in the same
conditions and row 6 to achieve a given FeS amount.

Important note: Please use only Stream temperature cells as variables for the temperature
iterations, ie. do not use species temperature cells.

E‘.ﬂ T arget Dialog M=l E3
File Edit Inzert Delete |terate
|=EL¢,L!G3
Target Calculation Sheet (Goal seek) =
Variahle Targei Tteration |
I atne Cell Bef.i Test walue lin Dol M atme Cell Fef. Walue Mlax
SCEAP 0.oo fan .81 0.00 100,00 (HEAT BAL | -5EI.T4“ Q.00 10
Fe wt-% 2374 2374 0.00 S000(HEAT BAL -50.74 Q.00 10
Fe wt-% 2374 2374 0.00 3000(Fe &mount 0540 0540 10
10
10
10 >
Ins How | Del Row | Set variable cell Set target cell Set goal value Iterate Selected Rows I
Exit | Iterate Al |

Fig. 8. Target dialog specifies the variables and target cell references.
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11.8

Graphics

Occasionally it is useful to see the results, of for example a heat balance calculation, in
graphical format. This can be carried out manually by making step by step changes to one
variable cell and collecting data from interesting cells, for example, to an Excel sheet.
Sometimes further calculations may be required after every step, which can be specified
using the Diagram Dialog. Step by step the procedure is as follows:

1.
2.

Select Diagram/Diagram Dialog from the menu.

Select the variable cell and press Set X-cell from the dialog. Select, for example,
cell C11, see Fig. 7.

Select a cell for the y-axis and press Set Y-cell from the dialog. Select, for example,
the Heat Balance cell at the bottom right of the form. You may repeat this step and
collect several cells whose values will be drawn to the diagram.

If other calculations are required between every step, press Target iteration and the
Target sheet will automatically open. Select the calculation rows that should be
iterated before the Y-row and press Set Target rows from the menu. The row data
will now be tranferred to the Diagram dialog into columns 4, 5, etc.

Fill the Diagram Settings as shown in Fig. 9. You must specify the MIN, MAX and
STEP values for the X-Axis. You can also specify the cell references, labels and
units manually in this form.

Press Diagram to create the tabular data for the diagram and Diagram once again
to see the final diagram, Fig 9.

The diagram can be modified, copied and printed in the same manner as other
diagrams in HSC Chemistry.

Show/Toolbar shows the drawing menu and Show/Object Editor shows the object
editor, which lets you specify the objects manually.

To return to the Heat Balance module, press Exit at the bottom left corner of the
diagram form.

From the diagram shown in Fig. 9 you can see that roughly 68 kg/h of scrap is needed to
adjust the heat balance to zero. Notice that the units in the diagram are kg/h and kW.
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%% Diagram Settings =]
-¥-Axis Range: Ing Row | Inz Col
kA bl e CTEF Del Row [vel Col
I 1] I 100 I 2 Clear target cells
Clear all
A2 [BaLics
Cell Reference Lahel | Units | Targetrowl|=~
X |FEEDIC1] HSCRAF: kg'h -
¥l |BALIGS BALANCE KW
12 -
4| | »
Cancel | Set X cell Target iteration Diagram
Set ¥1 cell Set llarget rows
% HSC Diagrams i =] B3
File Edt Inzert Delete Format Show  Help
KW Influence of Scrap Feed on Heat Balance
10
5 /
0
Heat Ba]a.n;ce//"
-5
-10 /
-15
20 Serap
0 20 40 60 80 100 kg'h

Fig. 9. Simple heat balance diagram.

In the following diagram (Fig. 10) the heat balance is automatically calculated before each
step, which is indicated by the number “4” in the Target row 1 column. This is done by
pressing the Target iteration button, selecting row 4 on the Target sheet and clicking the
Set Target rows button. The x-axis now gives the Fe wt-% and the y-axis the cooling
scrap required. The diagram may then be interpreted as the quantity of cooling scrap
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required to make the heat balance zero, when the Fe wt-% varies from 20% to 25%.

E‘.ﬂ Diagram Settings - |O
- ¥-Axis Range: Ing Bow | Inz Col
I 20 I 20 I 1 Clear target cells
Clear all
| A2 [FEEDICI
Cell Reference Lahel Units | Targetrow 1| =]
X |FEEDICY Fe wt-% -
Y1 |FEEDIC1] SCRAP: 4
2 | -
4| | 3
Cancel | Set X cell T arget iteration Diagram %l
Set X1 cell Set llargel rows ,
BN HSC Diagrams M=l E3
File Edt Inzert Delete Format Show  Help
Scrap kg'h Influence of Fe wi-%0 on Scrap Feed (Heat Balance = 0)
84
74
64
54 /
Scrap Feed
44
34
24
14
. / Fe wi- %0
200 210 220 230 240 250

Fig. 10. Diagram where the heat balance is automatically iterated to zero before every calculation step.
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11.9 Multiple balance areas

The previous Balance modules up to HSC 4.0 were restricted to one balance area (or
control volume) only. Since most processes consist of multiple balance areas, the new
Balance module enables the user to create up to 127 multiple balance areas. A balance
area consists of an INx and an OUTx sheet, where x denotes the number of the balance
area. These can then be connected to each other creating a realistic simulation of a process.
The example file FSF_process.BAL contains a highly simplified multibalance model of an
Outokumpu Flash Smelting Furnace process.

A new balance area is created by selecting either Insert/Balance Area to Right or
Insert/Balance Area to Left from the menu. This will insert a pair of INx and OUTx
sheets to the corresponding position. A balance area may easily be deleted by selecting
Delete/Balance Area. Deleting a single sheet of a balance area, for example an INx sheet,
is not possible. The balances are all automatically collected into the BAL sheet so please
do not modify this sheet.

IEEHeat and Material Balance - C:A\Hzch\B alance\F5F_process BAL

File Edit “iew Inzert Delete Fomnat Unite Calculate Tarnget Diagram  Option:  Help

LA IN1
BALANCE Temper. Amount Amount Asount Latent H Total H |~
oC kmol ke Nm? kWh kKWh |_|
1 |INI 30966 1825455 534633 209 144491
2 |ouUT1 26521 1825455 477 547 63375 1446401
3 |BALANCE -4 445 0,000 -57 026 65 i 0.00
4
5 |INz 352700 1342469 706 286 76.10 -273.10
6 |OUTZ 31314 1342469 670 363 482 57 27310
7 |BALANCE 3936 0.000 35921 406,46 0.00
8
9 |IN3 2383 164337 25020 1760 606
10 |OUT3 2819 164337 2439 4033 é.06
11 |BATANCE 0.431 0.000 0624 2333 0.00
12
13 |IN4 21.262 911638 477 321 32554 32207
14 |OUT4 21.262 911638 477 321 70.41 -322.07
15 |BALANCE 0.000 0.000 0.000 -23513 0.00
16
17 |IN3 21.102 221 332 477315 2,42 -537.34
18 |OUT3 21.102 221 332 477313 3242 53734
19 |BATANCE 0.000 0.000 0.000 -10.00 000 -
A v [ vl AN A OOTT AW A o0T: A NG A 00T A M4 A ouTd A Ns A outs AT 4] | L'J
kmol kg Nm? kWh kWh
Exit | Sweam | <|>| BALANCE@) 44457 oo sross[  eases] 0.00]

Fig. 11. The BAL sheet when the worksheet consists of 5 balance areas.

Linking the balance areas with each other is recommended to carry out after each
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individual balance areas operate properly. Linking may be achieved either manually with
formulae or automatically with the Copy - Paste Stream combination. Simply place the
cursor on a stream row in an OUTX sheet, or on a row that belongs to a stream, and select
Edit/Copy. Then place the cursor on a row in an INx sheet and select Edit/Paste Stream.
The stream will now be copied here so that the first row of the stream is the cursor
position. The kmol column of the pasted stream will consist of links (formulae) to the
copied stream, so that the material amounts of the streams will remain equal. The other
cells are directly copied as values. If the stream temperature cell in the copied stream is a
formulae then it will not be copied. In this case it is up to the user to decide how the stream
temperature for the pasted stream should be calculated.

It is also possible to create return streams, i.e. streams that return to a previous part of the
process, thus creating loops in the process. When pasting a stream into an already linked
part, a circular reference might occur. This is the case when links eventually refer back to
each other, i.e. iterations are needed to calculate the worksheet. Automatic iterations may
be done by selecting Format/Options from the menu and highlighting the Iteration
checkbox under the Calculation tab. Please be careful when changing the inputs of a
worksheet consisting of circular references. For example if a cell, which is part of a
circular reference, shows the message #VALUE!, it will not recover unless the links in the
cells are changed thus breaking the circular reference. Saving the worksheet regularly
using different names (Test1, Test2, etc.) is thus always recommended.
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File Edit “iew Inzert Delete Fomnat Unite Calculate Tarnget Diagram  Option:  Help
| C14 =0UT4IC11
INPUT SPECIES (1) Temper. Amount Amount Asount Latent H Total H |~
Formula *C kmol kg MNmé KWh kWh |
1 [Concenirate 25000 2589 1000080 (255 S]] QTS
2 |CuFe32 25000 4091 50800 n.17a 0o “ALE35
3 |Fed 25,000 [.669 SE.200 noiz a0 -1EEn
4 |Fedl 25000 0253 30.400 0006 .00 <1207
&  |Cal*ALROEF2R502 25000 0575 160,000 0058 .00 Hai |
6 (Flux 25000 1573 112000 042 an “AaE R
T |E02 25000 1426 E0 26 0034 0o SATHER
8 (*2FeO*35i032 25000 n.0zo 4032 n0m .00 813
9 (Cal*AROZ*25102 25000 0.0a¥ 18704 o0ay .00 <f39a
10 [Air (oxyzen enviched) 25000 25443 F12787 254535 ] 00
11 |22(g 25,000 14.067 450,114 320,584 a0 .00
12 Mg 25000 Q37T 202073 213749 .00 .00
13 Flue dusi (Boiler return) 50000 1160 29800 [:00A 199 A% EA
14 |Cuid 35D.EIEIEI| IZI.EIEQ! 12733 0002 .56 <366
15 |Fe304T) 350000 .04 11370 0002 .95 ~13a0
16 5102 350000 .00 00E2 0.0ao 0ot <034
17 |(Cal*AT0E*2502 350000 n.0zo 5635 0002 0.4z <2337
18 |Flue dust (ESP return) 305021 R EEE] 14200 003 125 2008
19 (Cu2o 305021 0.044 6,362 0001 .24 “1EY
20 |Fe304 305021 0025 S AES 0.0m 041 63T
21 S 305021 0001 0041 0.0ao .00 07
Callrt s 203251032 305021 0010 2812 n0m .20 11AY -
1 _|\ BL A N1 A OUTT A M A 0UT2 A N3 A 0uT3 A M4 A outd A s Aouts AT 4] | L'J
kmol MNm? EWh kWh
Exit | Steam | <[|>| BaLANCEQ@) 4445 e T | 0.00]

Fig. 12. The IN1 sheet (Flash Furnace) of the FSF_process.BAL example. The stream Flue dust is a
return stream from the boiler (Copy/Paste stream), thus creating circular references in the worksheet.

Automatically updated defined names (input and output kmol amounts) vary according to the
balance area. For example InAl, InC, OutFe for the first balance area will become InAl2, InC2,
OutFe2 for the second etc. Note that the defined names of the first balance area do not have

index numbers.
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IEEHeat and Material Balance - C:A\Hzch\B alance\F5F_process BAL

File Edit “iew Inzert Delete Fomnat Unite Calculate Tarnget Diagram  Option:  Help
| () I=InCaE*ﬁnal;rsis!L29ﬂDD
OUTPUT SPECIES (2) Temper. Amount Amount Amount Latent H Total H | =
Formula °C kmol kg Nm® kKWh EKWh |
1 Shg 1200000 1:204 55673 DA% 10489 37270
2 |FIFeO*302 1300000 0.243 171 848 0.040 T6.54 “2H9.73
3 |Fe304D 1300000 0.304 70422 0014 2299 =693
4  |Cu2oh 1300000 0.017 2415 0.000 060 =001
5  |CaD*AROIFIZI0Z 1300.000 0.0331 10989 0.004 4.37 4202
6 | White metal 1260000 0512 21465 0015 1760 606
T |Cudd 1260000 0.512 21465 0.015 17.60 6.06
8 |Flue dust 1260000 0.095 12,099 0003 401 <1920
0 |Cu20 12a0.000 0.017 2415 0.000 0.7 003
10 [Fe304 12a0.000 0.028 6,402 0.001 195 -h6d
11 502 1260000 0.049 2932 0.001 116 -11:19
12 |[Cal*ALR05*2302 1260000 0.001 0.351 0.000 0.13 =135
13 Flue zas 1260000 29409 921134 670287 35204 12194
14 (530402 1260000 2791 172779 63600 2062 17948
15 [Hi(g 1260000 12.393 347165 282 ATT 13623 136.23
16 0@ 1260000 14,225 455190 324210 16520 16520
17  Flue dusi (Comy. 1 returm) 1Za0000 0095 12,099 0003 401 -19.20
18 |Cu2D 12a0.000 0.017 2415 0.000 0F7 003
19 |Fe304 1260000 0.028 f.402 0.001 195 664
20 =02 1260000 0.049 2932 0.001 Lla 1119
21 ([CaD*ALROE*2302 1260000 0.001 0.351 0.000 013 <135
22 |Heatloss (Converter I 1000 &
4| v [ B AN A 00T A Me A oute A NG A 00T A Md A ouTd A NS A outs AT 4] | LH
kol kg Nm® EWh EKWh
Exit | Sweam | <|>| BALANCE@)[ 395 oo 3soni] 40646 0.00]

Fig. 13. The OUT2 sheet (Converter I), gives the output from the first part of the converter. The formula
=InCa2*Analysis!L.29/100 in cell C5 means that the total Ca is distributed as the percentage given in cell
L29 on the Analysis sheet.
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Drawing Flowsheets (Flowcharts)

Additional sheets may be used to collect, for example, all the necessary input for the process
into one sheet. They may also be used to collect calculated process parameters, for example the

amount of Cu in a stream. Figure 14 shows the process layout for the Flash Smelting Furnace
process.

"Insert, Graphical Object, ..." selection gives possibility to draw lines, rectangles, etc. on the
additional sheets. However, it is recommended to draw flowsheets using "Format, Border, ..."
and "Format, Pattern, ..." selection because these properties are more compatible with Excel 95,
97 and 2000. Arrows may be drawn using "Insert, Graphical Object, Arrow" selection.

HSC graphical objects are compatible only with Excel 95. This means that if you want to get
the graphical objects to Excel-files then you should save using "File, Save XLS 5 file, ..."
dialog.

IEEHeat and Material Balance - C:A\H=zch\B alance\F5F_process BAL

File Edit ‘iew Inzert Delete Fomnat Unite Calculate Target Diagram Optiohe: Help

| FB [1000
a B ' c/p | E | F [G6H 1 [ J [K[L[ M [N«
1 FSF Process flow |
pa (Fed walues are input values)
3 Fy p—d Flue dust: 500
| J(return) 298
5 Concenirate: 25 °C
6 I ll.'II]I].I]Iligﬂt Excess heat:
7 Flux: 25 oC 175.1 kW
8 1120 kg/h
9 Adr: 25 0C
10 5343 Nmi/h \
11 FSF (1)
12 Flue gas: 1350
13 4773
14 Matte: 1260 °C Flux: 25 oC Flue dust: 596
15 3608 kg/h 700 kg'h
16 Air: 25 o
17 ‘ 6 7062 Nmi/h
18 | |[Flue dust: 50.0 wi-%0
19 | frerwrmy 1221 W CONV.1(2)
20 Flue gas: 1260 °C
21 ¢ 6703 Nmi/h
22 Flue dusi: 12.1 kg/h
23 White metal: 1260 °C
24 815 kg/h -
v [ BL AR A OUTT A N2 A oOT A N3 JOUTI A N8 A OUTE A NG A GUTS b, Process flow Aandl 4] | L|J
Lol kg T KWh LWh
Exit | Sweam | <|>| BALANCE@[ 3956 o000 3span] 40646 0.00]

Fig. 14. Process layout and input sheet for the Flash Smelting Furnace process.
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Figure 15 provides a more detailed analysis of the process. The model is constructed so that the

inputs are given as species analysis and the outputs are calculated. The elemental distributions

are also inputs, in other words the user defines the wt-% for the elemental distributions into the
given species and streams. This is achieved using the automatically defined names, for example
InCa and InO2, and thus always keeping the elemental balance at zero. The model may then be
used to balance the heat balances of the process, which enables the user to calculate one

unknown parameter per balance area.

The unknown parameters calculated in the

FSF_process.BAL example are indicated by a light blue cell background. The calculated
parameters may be changed using the Target Dialog option, which is described in further detail
in chapter 8. Target Dialog.

IEEHeat and Material Balance - C:A\H=zch\B alance\F5F_process BAL

File Edit ‘iew Inzert Delete Fomnat Unite Calculate Target Diagram Optiohe: Help
: [75.08
A B | C D E F | 6 H 1 | J -
1 | FSF Process analysis —
% (Fed walues are input values)
4 INPUT ANALYSIS OUTPUT ANALYSIS
5 | |Flow Species Amount Unit  Amount Unit | [Flow Ar
G Concenirate: CuFedl '?5.1!'.'.1-% 7508 kg'/h | |Liguid Cu:
7 Fe 50 wi-% 588 ke/h | [Slag (iotal):
8 Fel2 20 wi-% 304 kg/h | [Flue gas (otal):
9 Call* A O3+ 23002 160 wi-%0 1600 kg'h | [Flue dusi (total):
10 | |Total: 1000 wi-%0 10000 kg'h
11 Flux: =02 70T wit-04p 803 kg'h
12 *#2Fe0*3102 3.6 wi-%0 40 kg/h
13 Call* A O3+ 23002 16.7 wi-%0 18.7 kg/h
14 | |Total: 1000 wi-%0 1120 kz/h
15 | |Adr: 02z 60.0 vol-%o 3206 INmd
16 Hig 400 vol-%o 2137 ngzﬂ
17 | |Total: 1000 vol-%o 5343 Nm®
18
19 | |FSF DISTRIBUTION CONVERTER I, DISTRIBUTIOT
20 | |Element Species Flow Amount Unit Element Species Fly
21 Cu Cuiah Llatte 880 wi-%0 Cu Cuiah L
22 CulO Alag 410 wi-% Culo il
23 Cul Flue dust 8.0 wi-% Cuo Fh
24 | |Total: 1000 wi-% Total:
29 | |Fe Fedl Llatte 105 wi-%0 Fe *2Fe0*31002 il
26 *2Fe0*3i02 Alag S0 wi-% Fe3ld ali
0 [ B A RT A OOTT A, N2 A DOTZ A, N3 A O0T3 A W& A 00T4 A N5 A 0TS A, Process flow & ind] 4| | l|J
Tanel Im? kK'Wh kWh
Exit | sweam | <|>| BALANCE@)[  39% o000 33021 40646 0.00]

Fig. 15. Detailed analysis of the input and output streams and the elemental distributions into different

species. The distributions are given in wt-% (weight percentage).
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11.10 General Considerations

In the Heat Balance module it is possible to use the new add-in functions provided by HSC
5.0. The functions should be enabled automatically, this may be seen from the File
selection in the menu. A checked HSCS.dll On indicates that the functions are available
and a checked HSCS.dll Off indicates that they are disabled. Sometimes it is necessary to
browse the location of the add-in file manually. This is done by selecting File/Add-Ins
from the menu and then browsing to your Windows system directory (for example
c\Windows\System in Windows 98) by pressing the Browse... button. Select the file
“HSCS5.dII”. A more detailed description of the functions available may be found in
Chapter 27. Excel Add-Ins. It is, however, not recommended to use add-in functions for
very large worksheets, since a complete recalculation of the worksheet is necessary each
time a change is made in the worksheet. This is the case only when using add-in functions.

Please do not use temperature formulae that are linked to other temperature values within a
stream, instead link them to the stream temperature cell or any cell in a user sheet.
Otherwise the temperatures will be updated only after the next change. Notice also that a
change in the temperature value is required for the whole stream to be updated accordingly.

Simple graphical objects may be inserted by selecting Insert/Graphical Object from the
menu. The shapes are: Line, Rectangle, Oval, Arc and Polygon. After inserting, the objects
may be modified by first selecting the object and then selecting Format/Object from the
menu.

The Latent H column (= specific heat) is used to describe the energy which may be
released when the compound is cooled down from the given temperature to 298.15 K. In
other words, it contains latent heats (= enthalpies of the possible phase transformations)
but also specific heats. The enthalpies given in the Total H column contain the values of
the Latent H column as well as the heats of formation reactions. These values are used to
calculate heat balances.

In molten mixtures such as oxide slags, substances can exist in liquid state at lower
temperatures than their melting points. In these cases it is possible to use an (I)-suffix at
the end of the formulae, see Fig. 1. This will force HSC to use data of the liquid state for
species with an (1)-suffix.

The “Red Font Shield” property is sometimes useful if you want to prevent accidental
changes to cells. You can activate this property by selecting Format Red Font Shield
from the menu. After this selection you can edit only those cells which contain red font.

If you have carried out a laboratory or industrial scale experiment or process calculations
you usually know:

1. The raw (input) materials and their amounts and temperatures.
2. The product (output) materials and their amounts, temperatures and analysis.
3. The input heat and heat losses can first be estimated as zero, if not available.

In order to calculate a heat balance you must first convert the (elemental) chemical
analysis of the raw materials and the products into input and output substances (species).
Sometimes this step is the most difficult, so you may choose to carry out this procedure
using the HSC Mineralogy Iterations module, see Chapter 22. Mineralogy iterations.
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When this is completed, simply type the input substances (species) into the IN1 Sheet and
the output substances into the OUT1 sheet. Immediately after that you will see the heat and
material balance on the bottom line. You can also test the procedure described in chapter 5.

It is important to check the element balance by selecting Calculate/Element Balance, in
order to avoid incorrect material and heat balances. This can also be used to check the
validity of the chemical analyses and the other amount measurements of the experiment if
the user input is based on this data.

When creating a multiple balance area model, selecting Calculate/Total Balance shows an
overview of all balance areas in one window. This is useful for a quick check where the
material and/or heat balance are not zero. It also shows the total (or net) material and heat
balance for all balance areas. It is then easy to see which balance areas produce heat,
which require heat, and indications of how the heat could be tranferred within the process.

On the basis of the final results, conclusions can be made as to whether extra energy is
needed or increased insulation is required or if the reactor needs cooling on a large scale.
The heat losses may also be determined using the HeatLoss module. Combining the two
modules provides a powerful way of calculating processes.

It is important to note that this is a real heat balance for engineering purposes, which also
takes into account the kinetic aspects if the user input is based on real experimental data.
The heat balance, which can be obtained from the equilibrium calculations, is theoretical in
this respect. It is valid only if the equilibrium is reached in the real process.
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11.11

Heat Balance Examples

See the examples provided by the HSC package by selecting File/Open from the menu, see
Fig. 1, and select some of the ready made files in the directory for editing. HSC 5.0 can
read the old HSC 2.0 Heat Balance text-files, but it cannot save them in the old format.
The new HSC 5.0 Heat Balance files save all the sheets and formats, not only the text data.

1.

Preliminary check for a heat balance (CUSMELT.BAL file)

For some processes based on reaction equations or equilibrium calculations, the heat
balance can easily be checked by entering the assumed input and output substances
as well as their temperatures and amounts, see example CUCONV.OHE and
CUSMELT.OHE, Fig. 1.

Adiabatic temperature of the flame (BUTANE.BAL-file)

In an adiabatic process heat losses from and heat input to the system are zero, i.e.
there is no heat exchange with the surroundings through the system boundaries.
Therefore, the adiabatic temperature equals the highest attainable temperature from
a flame or a chemical reaction. By typing the raw materials into the IN1 sheet and
the products into the OUT1 sheet it is possible to see the adiabatic temperature by
selecting Calculate/Temperature Balance from the menu, Fig. 3, see example
BUTANE.OHE.

Dimensioning of an evaporator (H20.BAL-file)

The evaporator dimensions can be optimized manually by typing the input
substances into the IN1 sheet and the desired output substances, amounts and
temperatures into the OUT1 sheet. Once these have been entered, you can start to
change the amount or temperature of the input vapor (input heat if heated by
electricity) manually, in order to find the optimum values. See example H20.OHE.

Net and gross heat value of coal, fuel oil and natural gas.
(Coall-, Coal2-, FuelOill-, FuelOil2-, NatGas1.bal-files)

The Heat balance module makes it possible to calculate the Heat Values (Calorific
Values) for different fuels. Examples for coal, fuel oil and natural gas are found in
the example files. Notice that the chemical structures of the fuel oil and coal are very
complicated, however, heat values based on the elemental analysis will usually give
sufficiently accurate results for practical applications.

Outokumpu Flash Smelting Furnace process (FSF_process.BAL-file).

This highly simplified process case consist of five balance areas linked together.
The balance areas are:

1) Flash Smelting Furnace

2) Converter I

3) Converter II

4) Boiler

5) ESP

The process input values are provided in the Process flow sheet and in the Analysis
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sheet. By pressing F8 or by selecting Iterate All from the Target Dialog, the heat
balances are calculated. The values calculated are in the Process flow sheet and
indicated by a light blue cell background.

6. Iron production process (Iron_process.BAL file).

The example in this file is a very simplified model of an iron production process
consisting of three balance areas:

1) Pelletizing

2) Coking

3) Reduction

The process and its most important parameters are shown in the Process flow sheet,
with a more detailed analysis available in the Analysis sheet. Notice that only the
material balances are zero and iterated according to what is set in the Target sheet
(or Target dialog). The heat balances are not iterated and therefore not zero.



